
 
EXPERIMENT 27 

 
FOURIER OPTICS 

 
 

 
 
 
 
 
Equipment list:- 
 
a) Optical bench and mounts 
b)   Beam expander laser diode module (λ = 635 nm)  
c)   Laser current regulator 
d)   Adjustable neutral density filter 
e)   One-dimensional and two-dimensional (mesh) gratings 
f)   Electrically heated wire as a source of the phase object 
g)   Lens 
h)   Adjustable slit 
i) Rotating diaphragm 
j)   Periodic spatial filter 
k)   Pinhole spatial filter 
l)    Black dot spatial filter  
m)  Magnifying glass  
n)   White card screen 
o)   Tape measure 
p)   Travelling microscope and light box 
 
References 
 
Hecht, "Optics", Ch. 11,13. 
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2 

1. INTRODUCTION 
 
The quality of the image produced by an optical system is determined by aberrations in the 
components of the system and also by diffraction effects.  Whether the light is coherent or non-
coherent is also important since the diffraction effects for coherent light are not the same as for 
non-coherent light.   This was realized by the physicist Abbe in the latter part of the last century.  
He developed a theory of image formation with coherent illumination.  This was of great 
importance in the development of high power microscopes. The ideas in the theory have also led to 
major areas of modern optics.  Though he did not express things in this way his theory implies that 
the image formation is intimately related to the spatial frequencies present in the object.  The 
passage or otherwise by the optical system of these spatial frequencies determines not only its 
resolution but affects the image sharpness.  The failure to pass certain spatial frequencies can result 
in false structure i.e. false detail can appear.  The deliberate suppression of certain spatial 
frequencies is known as spatial filtering and is of major importance in areas of modern optics such 
as confocal microscopy and image enhancement. This experiment deals with these ideas. 
 
Though the resolution of an optical system is important in determining the quality of the system, 
(and indeed until recent times was the only way), it is not the whole story.  In terms of spatial 
frequencies the resolution limit is the high spatial frequency cut-off.  It says nothing about how the 
lower spatial frequencies are passed by the system. A complete description of the performance of 
the system is to specify its performance as a function of spatial frequency. This information is given 
by the so-called optical transfer function. In its most general form this function contains the effects 
of aberrations as well as diffraction.  Since the diffraction effects are different, the function for 
coherent light is different from that for non-coherent light  
 

2. ABBE'S THEORY OF IMAGE FORMATION 
 
With non-coherent light the resolution of an optical system is determined by diffraction effects at 
the aperture of the system.  The essence of Abbe's theory is that when one is treating an object 
illuminated by coherent light it is necessary to consider the diffraction of the light by the object as 
well as by the subsequent aperture.  The ideas are most easily explained by considering a one 
dimensional grating as the object as in Fig.1 
 

  
   Localization of the spatial frequencies using a lens. 
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The incoming light is diffracted by the grating (situated at Σo) and this diffracted light is then 
diffracted by the lens Lt to form a Fraunhofer diffraction pattern of the grating on the focal plane Σt 
of the lens.  The light continues on past this plane to form the image of the grating on the plane Σi.   
 
A most important and remarkable thing that can be shown is that the lens acts as a Fourier 
transformer in that the diffraction pattern on Σt is the Fourier transform of the object. This means 
that the diffraction pattern is the spatial frequency spectrum of the object just as the Fourier 
transform of a function of time is its frequency spectrum. For the simple one-dimensional grating 
this means that the point S0 is the dc component, corresponding to zero spatial frequency, which 
arises because the light intensity cannot be negative.  The point S1 corresponds to the fundamental 
spatial frequency present in the object and the subsequent points S2 etc, further out, correspond to 
harmonics of this fundamental frequency at higher and higher spatial frequency. 
 
Not only is the diffraction pattern the Fourier transform of the object but the inverse Fourier 
transform of the diffraction pattern is the image.  The importance of the Abbe theory is now clearly 
evident.  Any modification of the diffraction pattern will change the image to some extent.  We thus 
have spatial filtering and the possibility of the introduction of false structure.  We see also that 
every lens must act as a low pass filter since to pass all orders of the light diffracted by the object 
the lens would have to have an infinite aperture.  The loss in high frequency information leads to a 
loss in sharpness of the image.  Finally there is the limit of resolution of the system.  For the image 
to be resolved it is clearly necessary that the first principal maxima, S1 and S′1́   of the diffraction 
pattern, be passed by the aperture since these correspond to the fundamental spatial frequency. This 
is the condition which replaces the Rayleigh condition for non-coherent light. 
 
In general, of course, the object is not just a one dimensional grating.  For a general two-
dimensional object, however, all the above ideas still apply (one can imagine the object to be a 
series of gratings of different spacing set at various angles to one another).  The diffraction by the 
object is now not as simple but notwithstanding this, a two-dimensional diffraction pattern is 
produced on the focal plane of the lens, a pattern which is the two-dimensional Fourier transform of 
the object and hence its spatial frequency spectrum. 
 

3. APPARATUS 
 
The apparatus consists essentially of an optical bench with various mounts used to support the 
different components of the optical system.  Fig.2 shows the set-up which is used for the majority 
of the investigations. 
 

  
FIGURE 2 

Experimental arrangement for examination of optical images. 
 
 

Laser with beam 
Paper on 
cabinet  

Adjustable density Objec CCD camera Spatial Len



4 

In turn the items of the system are as follows: 
 
1)  Laser:  this is a 1mW diode laser (λ=635nm) and is used as the coherent light source for the 
system.  The height of the laser can be adjusted as can its tilt in the horizontal plane.  It cannot be 
tilted in the vertical plane but it has been shimmed so that the beam is horizontal.  Laser beam is 
expanded by the build in telescopic beam expander. It can be focused at desired plane or set as 
parallel by moving the second lens (by rotating it). Care should be taken in using the laser.  DO 
NOT ALLOW THE LASER BEAM TO ENTER YOUR EYE. 
 
2)  Laser current regulator: the laser beam intensity can be adjusted by changing electric current 
supplying the laser diode. Additionally use 3) if beam intensity is still too high.  
 
 3)  Adjustable neutral density filter:  if the images observed are too bright the intensity of the 
beam should be decreased.  This is achieved by rotating a neutral density filter in the mount next to 
the laser. IT IS VERY IMPORTANT TO KEEP INTENSITY OF THE LASER BEAM LOW TO 
AVOID SATURATION OF THE CCD CAMERA OR EVEN IT’S DEMAGE. 
 
4)  Object:  for most investigations the object illuminated is a vertical line grating (one-
dimensional object) or a mesh (two-dimensional object).  Other objects are used, however. 
 
5)  Lens:  the lens used has a focal length of approximately 310 mm. 
 
6)  Spatial filter:  a variety of spatial filters are available for modifying the diffraction pattern in 
the focal plane of the lens.  These consist of an adjustable slit, a rotating (iris) diaphragm, a black 
point, a periodic filter and a pinhole.  The pattern at the focal plane is viewed using a magnifying 
glass. 
 
7)  Screen: the image is either formed on a white card mounted inside a cabinet in the line of the 
laser beam or on the chip of a CCD camera. 
 
8)  CCD camera: A CCD camera may be used to capture the image.  The camera is mounted on 
an adjustable stand so that its position can be adjusted to obtain a sharp and clear image of an 
object.  The camera can be rotated to face the beam or be removed away from the beam using a 
hinge mechanism.  
 
9)  Computer with associated software: A computer is used for observing and analysing the 
image captured by the CCD camera. This computer is equipped with a frame grabber board which 
digitises the images from the camera. The programme used to view or capture images is called 
“Camera”. Captured images can be analysed using “Scion Image” programme. 
 

4. GRATING DIFFRACTION PATTERN 
 
The object to be used in the majority of the later investigations is the vertical line grating supplied. 
Here we examine the details of its diffraction pattern. 
 
If the CCD camera at the end of the optical bench is facing the laser beam rotate it so that it is out 
of the path of the beam. 
 
Check that the laser beam is horizontal (if it is not, notify your demonstrator). 
 
To observe the diffraction pattern with greatest accuracy focus the laser beam onto a piece of 
paper fixed to the inside of the cupboard on the wall at the end of the optical bench.  Place the 
vertical line grating in its mount, near to the beam expander and adjust its position until all lines 
are illuminated.   
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Observe the diffraction pattern on the paper. Measure the separation, x, of the maxima, the so-
called orders of the diffraction pattern.  Determine from this the separation, d, between the slits in 
the grating and its associated error.  Use the formula which gives the angular positions, θ, of the 
different orders, n, viz. 
 
 d sin θ  =  nλ                n  =  0, 1, 2, 3 . . .  
 
where λ is the wavelength of the light (635 nm).  Since θ is small this becomes 
 

 d  =  
nλD

x                          n  =  0, 1, 2, 3 . . . 

 
where D is the distance from the slits to the diffraction pattern.  Measure D using the tape measure 
supplied. 
 
You will notice that a few of the maxima are either missing or weak. An order is missing if an 
interference maximum, determined by the above equation, occurs at the same place as a minimum 
of the diffraction pattern determined by the width of the slits.  If the slit width is a, these diffraction 
minima occur at angles θ given by  
 
 a sin θ  =  m λ 
 
There is conjunction between the diffraction minima and interference maxima, hence, when 
 

 
d
a    =  

n
m   

 
For orders to be completely missing d/a thus has to be an integer, since n and m are integers. If d/a 
= 5, for example, this equation shows the 5th, 10th, 15th etc orders are missing. If d/a is not exactly 
an integer some orders will be weaker, rather than missing. 
 
Estimate the first missing order (with its associated error) and hence obtain an estimate for the slit 
width a.   
 
Measure the slit width, a, and separation of the slits, d, using the travelling microscope.  Compare 
these values with those obtained from the diffraction pattern.   
 
Now we will investigate the diffraction pattern of the vertical grating in the focal plane of the lens 
using the CCD camera and the “Camera” programme installed on the computer. 
 
Remove the grating from the optical bench and adjust the beam expander so as to produce a 
parallel beam of light of approximately the same size all the way along the optical bench. Replace 
the grating on the optical bench so it is illuminated by the beam. Reduce light intensity to minimum 
using the laser current regulator and the adjustable neutral density filter. Place the lens on the 
optical bench in between the grating and the CCD camera around 310mm from the camera. Rotate 
the camera on the hinge to face a laser light. Run the “Camera” programme. Now you should see a 
diffraction pattern of the grating formed by the lens in its focal plane. Adjust position of the lens to 
observe a sharp image of the diffraction pattern. Change the position of the object moving it along 
the optical bench between the lens and the laser. What changes in the diffraction pattern do you 
observe? 
Hint: Move the camera aside to observe higher frequency diffraction pattern not just a central part 
of the spectrum. 



6 

Repeat measurement that you did previously knowing that camera image width is ¼ of inch 
(6.35mm). X and Y position of the cursor and intensity of the image at this point can be read in the 
“Info” window (“View->Info”). 
Replace the vertical grating object with fine mesh. What is the main difference in the diffraction 
pattern between those two objects? 
How a diffraction pattern in the focal plane changes when you replace the fine mesh with a coarse 
mesh? 
 

5. IMAGE FORMATION WITH COHERENT LIGHT 
 
In this section we look at the images of objects illuminated by coherent light and see how these 
images are modified by spatial filtering in the focal plane of the lens used to form the image.  The 
set-up for these investigations is as shown in Fig.2. 
 
5.1 Image of a one-dimensional grating 
 
An image of the object is formed using the lens provided.  The image should be observed using 
CCD camera. 
Using the approximate focal length given (310mm) calculate the position of the lens and the object 
to achieve magnification of 0.5. Move the lens and the object to that position. Fine adjust position 
of the lens to have the image in focus.  Note the image and its main features. How to change 
position of the lens to achieve image magnification of 2? Verify your guess. 
 
 From the object, lens and image positions determine the focal length of the lens exactly. 
 
5.2 Spatial filtering 
 
Place the spatial filter mount so that a white card held in it is at the focal plane of the lens.  View 
the pattern on the screen and check, approximately, that it is the same as the diffraction pattern 
observed in Section 4.    
 
Adjust the lens position until the image is sharp and clear. From the “Selection” menu of the 
“Camera” programme choose “Select for FFT”. This will select a central region of the image 
which horizontal and vertical size in pixels is a power of 2. This is necessary because “Scion 
Image” programme will use so called Fast Fourier Transform (FFT) algorithm designed for such 
images. When you are happy with the quality of the image save the selection to a file (in “BMP” 
format).  This file will be used in later stages of the experiment. 
 
Examine the effect on the image of spatial filtering in the focal plane.  You should try removing 
different spatial frequencies using the masks of different width and passing spatial frequencies 
using the adjustable slit and the adjustable iris.  In this context at least the following four cases 
should be tried:- 
 
1) Pass only the central frequency (mask the rest). 
2) Pass the central and two side band frequencies closest to it. 
3) Pass high frequencies only. 
4) Pass one side only. 
 
Record your observations and give an explanation for all of the observed effects.   
 
You should be looking for not only gross changes to the image, that is the introduction of false 
structure, but other effects such as a decrease in sharpness of the image and changes in the relative 
brightness of the bright and dark parts of the image. 
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5.3  Computerized image analysis 
 
• Now close the ”Camera” programme  and run the ”Scion Image” software. 
 
• Load the file that you have saved earlier.  Perform a FFT on the image (“Process->FFT-

>FFT”). This will result in a diffraction pattern (in a new window) observed in the focal plane 
of the lens. The programme use to assign black colour to the highest values of the spectrum, so 
the image of FFT will look as inverted image you observe at the focal plane of the lens. To 
rectify this (if you wish to do so) choose “Edit->Invert” menu.  

 
• Perform an inverse FFT on the FFT window.  The result that will appear on a new window 

should be the same as the original image. 
 
• Now close all windows except the main image window. Produce again a FFT of this image. 
 
At this stage we would like to remove some of the spatial frequencies from the diffraction pattern 
and examine its effects on the final image.  To do so we will paint a mask on the FFT window. This 
can be done by painting with the brush or by selecting a shape like rectangle or ellipse and filling 
selection using “Edit->Fill” menu (Ctrl+F). Black areas will pass the corresponding frequencies 
and white areas will filter out the corresponding frequencies.  It is not, however, possible to both 
pass and filter during the same inverse transform.  
 
 
Repeat procedures 1-4 given in section 5.2 on the saved image using the FFT software and explain 
the results. 
 
 
 
5.4  Image of a two-dimensional grating 
 
Now close the “Scion Image” software and run “Camera” programme. 
Use a slightly dusty fine mesh object. Observe its Fourier transform in the focal plane of the lens.  
Try to filter its image to have just a dust to be visible. What shape and size of the filter should be 
used? 
What filter will be needed to achieve an image of the mesh without a dust visible? 
Hint: See Hecht “Optics”, Ch. 13. 
Select a part of the image for FFT and save it to file. 
Open this file in “Scion Image” and repeat all the spatial filtering you did above using digital 
processing.  
 
 
5.5  Image of phase objects 
 
The objects examined so far are what are known as amplitude objects.  These are observable 
because of the variations they cause in the amplitude of the light waves.  In contradistinction to 
these are phase objects those which are transparent, thereby providing no contrast with their 
surroundings, but which alter the phase of the waves. The optical thickness of such objects varies 
from point to point as either the refractive index or actual thickness, or both, vary.  
 
Biological specimens are often of this nature.  Various techniques have been developed to render 
such objects visible. All these techniques convert phase variations into amplitude variations which 
are visible. All of these, (apart from staining which has its drawbacks), rely on spatial filtering in 
the focal plane of a lens.  The best of these is the phase contrast method, used in phase contrast 
microscopes, which makes use of a π/2 phase shifting filter.   
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Good results, however, can be obtained by just removing certain frequency in the diffraction 
pattern.   
 
In the Dark Field technique, the central maximum is removed. This central maximum represents 
the incoming beam unperturbed by the object. If this is removed, we are simply left with the 
diffractive contribution of the object. 
 
In the Schlieren Technique all maxima on one side of the pattern (and the central maximum) are 
removed. 
 
For further information see Hecht section 13.2. 
 
A close approximation to a true phase object would be the heated air above a hot wire. This should 
be investigated. 
 
Place a wire heater in the object’s mount. Using the computer display, observe the image of the 
wire.  Adjust the wire that only its top is visible (the wire should be placed along the laser beam). 
Switch on a current to heat the wire. Investigate the effect on this image of using the Schlieren 
technique of masking in the focal plane of the lens. Comment on your results. 
 
QUESTION:- Why won’t we get the same result if we artificially remove the frequency 
components within the computer? 
 
 


